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GWDG

Structure
B Joint data and IT-comptence center for the University of Géttingen, University clinic
and the Max-Planck-Society
B Established in 1970
B Shareholders Max-Planck-Society and Unversity Gottingen, each 50%
Mission
B It is the mission of GWDG to support and enable science — now and in future - by
applying appropriate technologies, developing innovative solutions, and providing
reliable services
B Plan, implement and operate IT infrastructures together with/for customers
Central responsibilities
B Modern and secure IT infrastructure
B T support for excellent research
B In-house research for innovative IT services
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GWDG

Supra-regional tasks

Sebastian Krey

National High Performance Computing Center (NHR-NORD@Go6ttingen)
National HPC Center of the DLR

Upcoming regional HPC center for Lower Saxony (HPC.NDS)

Al service center for sensitive and critical infrastructures (KISSKI)
Partner in the Al Factory HammerHAI

Data center in four NFDI consortia

Host for DARIAH-EU, German National Library, GFBio, NUM CODEX, MWS,
WirLernenOnline, Text+, etc.

Cloud operator, including the Academic Cloud for universities in Germany
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German HPC Infrastructure

HammerHAI

I «( KI-Servicezentrum fir sensible
und kritische Infrastrukturen

NHR-NORD@GOTTINGEN
"Emmy", "Grete"

SGWDG
Scientific

Compute

Cluster
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NHR Alliance - Members
Rhein-Westfalische Technische Hochschule Aachen
Zuse Institute Berlin (ZIB)
Technische Universitat Darmstadt
Technische Universitat Dresden
Friedrich-Alexander-Universitat (FAU) Erlangen-NUrnberg
GWDG/Georg-August-Universitat Gottingen
Karlsruhe Institute of Technology

Paderborn University

Consortium Sid-West (Goethe University Frankfurt,
Rheinland-Pfalzische Technische Universitat Kaiserslautern-Landau,
Johannes Gutenberg Universitat Mainz, Universitat des Saarlandes)
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KISSKI - ein KI-Servicezentrum fur Kritische Infrastrukturen

| KISSKI

@ UniGcsttingen | GWDG | CIDAS | UMG |
aQua | LUH | L3S | LIFE | LUIS | MHH |
Fraunhofer IEE

Sensible und kritische Infrastrukturen
Medizin & Energie

KI Service
™ Zentrum
1 wasso Parteer sttt .
[ . Hasso-Plattner-Institut
Bildungs- und Beratungsangebote.

Einsatz von Kl in Wirtschaft &
. Gesellschaft

v .
R - --\ G m&é‘;‘;ﬁ-\! . Uni Bonn | Fraunhofer IZB |

Forschungszentrum Julich | RWTH
Aachen | TU Dortmund | Uni Paderborn
KI-Hardware, KI-Beratung, KI-
Schulungen sowie multimodale und

. )
\ ‘““"’M'sc transferierbare KI-Modelle
. TU Darmstadt

Erklarbarkeit, Generalisierbarkeit
und kontextuelle Anpassung
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Services for HPC and Al

B Infrastructure

B Scientific Software
B Consulting

B Training

B Support

One current focus is on usability, availability and security
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Our Offer - Al for Everyone

B Comprehensive offering around Al

B Solutions available in browser and via API
» ChatAl - Chatbot

B Hardware resources
» From ARM, RISC-V to Graphcore and more

B Consulting services

B Custom development projects

B Training programs in HPC and Al

» GWDG Academy
» KISSKI Training Offer
» Custom courses available upon request

Sebastian Krey 'GE’WDG

Beratung/
Consulting

Infrastruktur-
services

Training /
Schulung

Auftrags-
entwicklung
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CPU System “Emmy”

M Phase 1 (2018) — out of operation

» 448 standard nodes (2 Xeon Gold 6148, 2x20 CPU-Cores, 192 GB memory)
» High Mem nodes: 16x 768 GB

B Phase 2 (2020) — to be replaced in Q2/2026

» 1022 standard nodes (2 Xeon Platinum 9242,
2x48 CPU cores, 384 GB memory)

» High Mem nodes: 16x 768 GB, 2x 1,5 TB ﬁ ~rir—r
» 3 GPU nodes? (2 Xeon Gold 6148, 2x20 CPU cores, - ' ﬂ
200 — L, L

768 GB memory, 4x NVIDIA V100)
B Since 2021 operated for the NHR alliance

®The GPU nodes have been moved to Grete

JGWDG
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CPU System “Emmy”

Add-on procurement 2022: Phase 3

B NHR NEC CPU cluster (replacement of Emmy P1)
» 2x Intel Sapphire Rapids 8468 (48 cores) per node

» 164x 256 GB, 164x 512 GB, 12x 1 TB, 2x 2 TB nodes

B NHR+SCC NEC CPU add-on 2023
» 20+44x 512 GB, 16+4x 1 TB, 1x2 TB
» 4 nodes per 2U chassis, each with

* 2x Intel Sapphire Rapids 8468 (48 cores) CPU
¢ 1x Cornelis Omni-Path (100 Gbit/s) HCA

10/40
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GPU System “Grete”

B Technical specification: 103+3 nodes equipped with
» 101 MEGWARE nodes (7 racks)

e 2x AMD Epyc 7513 CPU (32 “Milan” cores, Zen 3 microarch.)
¢ 512 GB memory (DDR4, 3200 MHz)

e 2x 1 TB NVMe SSD

* 4x NVIDIA A100 GPU (SXM4, 80/40 GB HBM2 memory)

e 2x Mellanox InfiniBand HCA (HDR)

» 2 nodes with twice the cores (Zen 2 microarch.), RAM, GPUs, and VRAM
» 3 GPU nodes moved from Emmy Phase 2

B Installed at RZGo

LGWDG
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GPU System “Grete”

B MEGWARE GPU cluster Grete
» Nodes from a range of projects (modular procurement):
34x NHR, 22x REACT, 35x Al Service Center,
9x Institutes/SFBs, 3x SCC
B MEGWARE GPU Add-on 2024
» 25 nodes, each with
e 2x Intel Sapphire Rapids 8468 (48 cores) CPU
* 4x NVIDIA H100 SXM5 (94 GB) GPU 5
e 2x InfiniBand HDR (200 Gbit/s) HCA
» 3U per node, DLC
» via RfP extension option Al Service Center

B Joint operational concept since the start of operations.

LGWDG
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| “Emmy” and “Grete” NG

Next generation 2026/2027: Phase 4

New platform for the next CPU and GPU clusters at GWDG
Modular procurement for NHR, SCC, HPC.NDS and KISSKI
350+ MEGWARE Eureka CPU nodes

2 installation phases

AMD Turin and Venice CPUs (2x128 cores per node)
768-4096 GB memory

3,84 TB NVME SSDs

Omni-Path CN5000 400G interconnect

15+ GPU nodes with 8xB200 Nvidia GPUs

Reuse of CoollT DLC infrastructure, racks and PDUs

.:..GWDG
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The “Future Technology Plattform” (FTP)

B Heterogeneous hardware for development tasks

B Direct access via shell and batch system
B Offered technologies:
» Intel Habana Gaudi 2
NVIDIA Grace Hopper
GraphCore IPU
Esperanto.ai
SpiNNaker
Ampere Altra
NVIDIA Bluefield 2
» AMD MI300A

B Full documentation and Quick Start Guide at HPC docs
B Courses on the heterogeneous hardware at the GWDG Academy

VVVYVYVYY

LGWDG
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Storage

B CephFS based HDD storage (23 PiB) successfully replaced old HDD Lustre as
capacity storage

B New 1.6 PiB all-flash storage with MEGWARE supported Opensource Lustre
as WORK storage at the MDC

B SSD based CephFS (0.75 PiB) well received fur midrange performance
applications

B VAST Data highly reliable enterprise storage with consistent low read
latencies for Al

B DDN 2xES400NVX with Exa 6 and upgraded 15 TB SSD still sufficient fast
main WORK storage at RZGO

B HSM storage succesfully migrated to new GWDG central HSM platform
(currently still StorNext HSM, but probably Versity ScoutAM in the future)

._-,iGWDG
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Selected Challenges Mentioned by Users

Experience with Linux-Systems is limited
Difficulty to debug distributed/parallel programs
Getting access to the system

Porting applications between centers
Interactive access - replacing workstations
Managing own projects, data and collaborators

Ingress/Egress of data

Need many concurrent users for training

LGWDG

Sebastian Krey BUX AGM 2026 16/40



Site-update

Usability Data protection and security
o] Jele}

Conclusion

Means to Lower the Bar - Usability

B Users want to do science and don’'t want to become computer scientists

B Goal: Empower users to do science via

>

vvvyYVvYyy

>

Tools

Prepared environments
Support

Consulting
Co-development
Training

Community

B Data management, data exploitation is part of science, too!

Sebastian Krey
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JupyterHPC

B Quick and easy way to access HPC resources vic Server Options
» No ssh setup necessary Ferepos =y -
» Frictionless and comfortable even for beginners - .
» Very useful for courses, trainings and fallback fo @

B CPU and GPU nodes available e stessn

B Classic Jupyter notebooks with various kernels DJQ h
» Python, Julia, R, Bash, SageMath
B All container recipes open source ©
» Easy to build and run your own containers

RStudio @ || coceroe

LGWDG
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HPC Desktops

B Goal: own HPC-powered workstation
B Integrated with Jupyter HPC
B Fully featured Linux desktops via webVNC
» KDE, Gnome, XFCE available
B Fully hardware accelerated rendering on GPU nodes
» Performant software rendering via llvmpipe on CPU nodes

B Complete HPC environment accessible
» Regular module system, same as in standard ssh sessions
» Documentation applies unchanged
» Possible to start Slurm jobs from desktop sessions

.:..GWDG
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Data protection and security

Secure HPC environment for batch processing of medical data
Workflow adapted for other types of critical data
Further improvements to simplify deployment and scale out in development

Certification of processing data of highest non-classified data protection
levels in preparation

B All OS image and configuration changes only with signed Git commits

B Critical backend system administration only by
dedicated priviledged admin workstations (PAW)

B Central logfile protection against manipulation

Next step: Securing HPC deployment with Secure Boot (mostly done)

._-,iGWDG
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Secure Boot

B Opensource deployment tool Warewulf

B Communication with Warewulf SSL secured

B Signed secure boot enabled iPXE bootloader

B Signed custom kernel modules with own custom key

B Deployed custom key to BIOS of all user accessible nodes

B Only one hardware plattform did not work (soon to be phased out)

.:..GWDG
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What are privileged admin workstation

Terminology from the Microsoft world
B Centrally managed devices for administration of critical infrastructure

B Maximize privilege separation (admin account of PAW has no admin
privileges on the critical infrastructure and vice versa)

Dedicated network segment (VPN profile)
Restricted network access (no internet access)
Restricted software availability (only tools necessary for the task)

Logging of configuration changes and software installations

._l,iGWDG
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Why and for what use PAW?

B In MS world: All tasks requiring domain admin privileges (root on all nodes
of the domain)

B Jumphost for external admin access
B Central logserver

B Key management systems

B Build infrastructure for OS images
B Network management

LGWDG
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What is required and desired for setting up a PAW?

B Required

» Automated deployment and configuration of PAW

» Monitoring of configuration and software installations on the PAW

» Central logging and analysis infrastructure for monitoring data

» Network or VPN profiles for accessing only the critical infrastructure via PAW
» Automated user setup

M Desired

» No complicated device management infrastructure
» Personalized work environment on PAW should be possible
» Software installation from white listed pool

LGWDG
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GWDG HPC PAW solution

B Management:

>
>
>
>
>

Mainly based on Fedora and Kickstart

Installation ISO and repo config from trusted mirror
All configurations in internal Git repository

Git repository requires signed commits

List of approved keys for signature also in Git

B Configuration

Sebastian Krey
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UEFI Secure boot

Systemd-boot without kernel commandline editor

root account locked, LUKS, preconfigured sudo, firewalld, etc.
Removal of remote management tools (SSH server, cockpit, etc.)
pam-u2f for 2FA

User setup includes eduroam and eduVPN setup

Shell script for software installation kiosk

Shell script with systemd timer for monitoring

#iGWDG BUX AGM 2026 25/40
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PAW logging infrastructure

B Graylog based

B Daily Systemd timer executes monitoring script and creates JSON
B Logging of Laptop type, Serial number, BIOS information

B rkhunter results

B All software packages with version (package manager and flatpaks)
B All executeables with set SUID, SGID or capabilities

LGWDG
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Why WORM logs?

Processing risk class D information (e.g. medical data) requires auditable access
logs. This means:

B Central log aggregation

B Verifiable integrity

B Redundant long term storage

B Prevent changes to log files

B No deletion from a single person

LGWDG
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How to solve the requirements?

Central: Redirect Journald to Rsyslog, send Rsyslog to central server,
individual files for each server

Integrity: Daily lodfiles, create checksums
Redundant storage: Offsite backups (incl. checksums) on tape

Deletion prevention : root is god — difficult (can even change SELinux settings)

LGWDG

Sebastian Krey BUX AGM 2026 28/40



Site-update Usability Data protection and security Conclusion
000000000e000000000

File modificationdeletion prevention

Modificationdeletion prevention from normal users easy:

B Extended attributes append-only and immutable

B Creating new log files with apppend-only prevents deletion of older log
entries

B Adding immutable attribute at the end of the day (before checksum
creation) to prevent deletion

B Integrity check of scripts handling these operations with checksums

Superuser root still has permission to remove these extended attributes
— can modify or delete files and hide it by creating new checksums.

Sebastian Krey "-'iGWDG BUX AGM 2026 29/40
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Further integrity enhancing measurements

Securing remote root logins:

B Changing the append-only and immutable attributes require
CAP_LINUX_IMMUTABLE

B Removing this capability from sshd via (immutable) service override
— root via SSH has lost the permission to change append-only and
immutable attribute

Remote administration via SSH still possible

Prevent usage of IPMI remote and serial console, e.g. no network connection

B Prevent local IPMI usage/configuration change by disabling OS access to
BMC (BIOS setting)

._l,iGWDG
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Further integrity enhancing measurements

Securing local accesss:

B Server location in accesss restricted area of data center

B Persons with access to data center area must not know password for root or
sudo enabled user accounts

B Persons with local login permissions must not have permission to access the
restricted data center area alone

B Additionally require 2FA for local login (e.g. FIDO Key via pam-u2f)

.:..GWDG
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Trusted Research Environments (TRES)

B TREs provide highly secure environments for analyzing sensitive data
B All computations and analysis are conducted entirely within the TRE
» Results are manually reviewed pre-publication
B Based on the "5 SAFE" framework from the UK Office of National Statistics
B Also known as:

» Secure Processing Environments (SPEs) (Common in DE/EU)
» Secure Data Environment (SDE) (Common in England; Especially NHS)
» Data Safe Havens (Common in UK; Especially Scotland)
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Other Reasons for a TRE

B Reprocucibility
» Controlled Environments
» Container-Images are publishable

B HPC-Resources (incl. GPU-Access)

» Big Data, for example Genome Analysis

» Machine-Learning Models
B Outsourcing and Centralizing Security/Administration Burden
B Legislative Pressure

» Europe: European Health Data Space
» Germany: Gesundheitsdatennnutzungsgesetz

._l,iGWDG
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Safe People
» Trustworthy institutions and “Know your Customer”

» Completed training, Signed user agreement
Safe Projects

» No access without data owner’s approval
Safe Settings

» Data is only processed within the TRE
» No internet access, no download possible

A Safe Outputs

» Manual approval of exports before publication
» Focus: No re-identification; Only aggregated data

Safe Data
» Data is pseudonymized when ingested into the TRE

LGWDG
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On-Premise HPC-based TRE: GOTRE

Technical Features Organizational Features
B Zero-Trust Architecture B High Usability despite Strong
B End-to-End Encryption on file Security
system level » Access via web interface
B Multi-Factor Authenticati » Graphical desktop environment
ufti-ractor Authentication » Supports non-web-based
B Collaborative Work possible applications
> Analogous to Windows Fileserver B Embedded in HPC Infrastructure
B Complete Audit-Log » High Performance
B One Key per File » Machine-Learning support via

Sebastian Krey

» Secure Sharing via Key GPUs

Management System
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GOTRE: Architecture

Cluster I SLURM Web browser
=

pp—
Singularity | Singularity _
nipemmlgsy:em Job distribution jupyterhub

Hardware

Singuiarity | Singutarity
= =)

Singularity | Singularity

Hardware Operating System
T T

Hardware

==
B |gocryetfs e=[kus] c ACADEMIC
cLouD

I Storage I

wazuh. 15 Grafana
Prometheus rsysl_aE
——

SEDG
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GOTRE: Interface

o Jupyter

Status: Connected | Remote Clipboard | Hub Control Panel
Activities (] Terminal ~

qwdg de/ind

HOME

This s the GWDG HPC Documentation, organized by topic both in the.

gttt h it nd b, I a2y e, oo sn
you will most likely find what you are looking for under start here. In case

il mot ity o e kg o o .1l 20 ttps: /relion.readthedocs.io
you v g someing spctc, e e s e s

functon o rowse oue large catalogus of onten vecty. I
Current Give sl fere oispey:

[Running jobs [inputto this job ]

the SCC and NHR to a

rsession -u 14326

<udio rses u u14326
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GOTRE: Interface
Z Jupyter Remote Desktop X | + ~ x
<« c 08 hpc.gwdg. P L H OO0 =
B A % @ @ © Ebscw [IB3-Rooms ¥ Meetings  HPC [EAESGCMVSCTR(CTR... <, Cluster Storage Map FFG @ ServiceDB @ You Don't Want XTS o »
i~ Jupyter
Activities  €) Firefox v Jun17 19:47
[a] Z DL_LocalData... (2) - Jup. X o v - x
« [¢] O D localhost:8888/lab/tr I @ so% % )
Fle Edt Viw R Kemel Tobs Sewngs Help
mlO X | ® Inferenced.sggregatefson. X | & meistipy X+ = DL-LocaData pynb + o
. 8 Prhon3ipkene) OS | B + X 0 0 » ® C » Code & Python 3 (pykeme) O
Epoch 415 T &
+ 2 422/422 65 13ns/step - accuracy: 0.9791 - loss: 0.0695 -
Vtest: (10000,) val accuracy: 0.9893 - val loss: 0.0408
Epoch 5/15
fron matplot import pplot as pit a22/422 6 13ns/step - accuracy: 0.9625 - loss: 0.0588 -
plt.suptitle( Fl'st 9 im: val_accuracy: 0.9882 - val loss: 0.0486
» for i in range( Epoch 6/15
Pt wbp\m 3041+ 422/422 65 13ns/step - accuracy: 0.9836 - loss: 0.0537 -
Bt Snchoutteatn A111. caspeplt get_casp('gray’)) L sccuracy: 09002 - val_loss: 0.0344
pEcCation () 422/422 6s 13ns/step - accuracy: 0.9842 - loss: 0.0502 -
val_accuracy: ©.9917 - val loss: 0.0347
First 9 images Epoch 6/15
a22/422 65 L3ms/step - accuracy: 0.9856 - loss: 0.0462 -
0 0 val_accuracy: 0.9913 - val_loss: 0.326
Epoch 9/15
10 " 422/422 65 13ns/step - accuracy: 0.9858 - loss: 0.0446 -
val accuracy: 0.9927 - val loss: 0.0309
Epoch 10/15
20 20 a22/422 65 14ns/step - accuracy: 0.9876 - loss: 0.0399 -
val_accuracy: 0.9898 - val_loss: 0.6329
Epoch 11/15
0 0 422/422 65 15ms/step - accuracy: 0.9872 - loss: 0.0389 -
val accuracy: 0.9927 - val loss: 0.0319
10 10 ’ Epoch 12/15
422/422 65 15ms/step - accuracy: 0.9884 - loss: 0.0354 -
Simple 1 3@ Pyhon3 (pykernel) | die Mode: Command @ Ln1,Coll DL LocalDataipynb 1 L1
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Outline

Conclusion
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Summary

B GWDG offers various HPC resources
B There are many ways to get access
B Besides performance, usability and availability can matter

B Providing highest data protection standards important esp. for medical
research

B Combination of data protection and good usability possible

.:..GWDG
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